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Çàíÿèòå 6. Ðàáîòà ñ áàçàìè äàííûõ ñðåäñòâàìè Visual Basic

ÇÀÍßÒÈÅ 6.

ÐÀÁÎÒÀ Ñ ÁÀÇÀÌÈ ÄÀÍÍÛÕ

ÑÐÅÄÑÒÂÀÌÈ VISUAL BASIC

Ïàíüãèíà Íèíà Íèêîëàåâíà

Visual Basic ïîçâîëÿåò äîñòàòî÷íî
ëåãêî ñîçäàâàòü ïðèëîæåíèÿ äëÿ Windows,
â òîì ÷èñëå è ïðîãðàììû äëÿ ðàáîòû ñ
áàçàìè äàííûõ � Databases.

Ïî îïðåäåëåíèþ áàçà äàííûõ (ÁÄ) �
ýòî ñîâîêóïíîñòü âçàèìîñâÿçàííûõ, òùà-
òåëüíî ñòðóêòóðèðîâàííûõ äàííûõ, ñî-
áðàííûõ ñ öåëüþ õðàíåíèÿ, íàêîïëåíèÿ,
ïîèñêà è âûäà÷è â îïðåäåëåííîé ôîðìå.

Íàèáîëåå ïîïóëÿðíûìè ñ íà÷àëà
80-õ ãã. ñòàëè è äî ñèõ ïîð îñòàþòñÿ ðå-
ëÿöèîííûå (relational) ÁÄ. Äàííûå â òà-
êèõ áàçàõ õðàíÿòñÿ â îäíîé èëè íåñêîëü-
êèõ òàáëèöàõ, ñâÿçàííûõ ìåæäó ñîáîé.
Êàæäàÿ òàáëèöà èìååò ñîáñòâåííûé, çà-
ðàíåå îïðåäåëåííûé íàáîð èìåíîâàííûõ
êîëîíîê (ïîëåé). Ïîëÿ òàáëèöû îáû÷íî
ñîîòâåòñòâóþò àòðèáóòàì õðàíÿùèõñÿ äàí-
íûõ (ñóùíîñòåé). Êîëè÷åñòâî ñòðîê (çà-
ïèñåé) â òàáëèöå ìîæåò áûòü äîñòàòî÷íî
âåëèêî, è êàæäàÿ çàïèñü ñîîòâåòñòâóåò
îòäåëüíîé ñóùíîñòè.

Ñóùåñòâóþò ñïåöèàëüíûå ïðîãðàìì-
íûå ñðåäñòâà äëÿ ðàáîòû ñ ðåëÿöèîííû-
ìè ÁÄ, òàê íàçûâàåìûå ñèñòåìû óïðàâëå-
íèÿ áàçàìè äàííûõ (ÑÓÁÄ) � DataBase
Management System (DBMS). Íàèáîëåå
ðàñïðîñòðàíåííûìè íà ñåãîäíÿøíèé äåíü
ÿâëÿþòñÿ  ÑÓÁÄ Oracle, MySQL, Informix,
Visual FoxPro, MSSQL è MS Access. Êðî-
ìå ýòîãî, âèçóàëüíî-îðèåíòèðîâàííûå ÿçû-
êè ïðîãðàììèðîâàíèÿ, íàïðèìåð, òàêèå
êàê Visual Basic, Delphi, Visual C++, îá-
ëàäàþò óäîáíûìè è ìîùíûìè ñðåäñòâàìè
äëÿ ðàáîòû ñ áàçàìè äàííûõ.

Ðàññìîòðèì íåêîòîðûå âîçìîæíîñ-
òè ðàáîòû ñ áàçàìè äàííûõ â Visual Basic
íà ïðèìåðå áàçû äàííûõ «Ïëàíåòû Ñîë-
íå÷íîé ñèñòåìû è èõ ñïóòíèêè».

ÐÀÇÐÀÁÎÒÊÀ È ÑÎÇÄÀÍÈÅ ÁÄ

Ðàçðàáîòêà è ñîçäàíèå
áàçû äàííûõ (ÁÄ) âêëþ÷àåò
ñëåäóþùèå ýòàïû: ïðîåêòè-
ðîâàíèå ÁÄ, ôîðìèðîâàíèå
è íàïîëíåíèå ÁÄ.

1. ÏÐÎÅÊÒÈÐÎÂÀÍÈÅ ÁÀÇÛ ÄÀÍÍÛÕ

Äëÿ ïðîåêòèðîâàíèÿ
ÁÄ ñëåäóåò îïðåäåëèòü:
• êàêèå äàííûå áóäóò õðà-
íèòüñÿ â áàçå;
• òàáëè÷íóþ ñòðóêòóðó äàí-
íûõ;
• ñâÿçè ìåæäó òàáëèöàìè.

Èíôîðìàöèþ äëÿ ÁÄ «Ïëàíåòû Ñîë-
íå÷íîé ñèñòåìû è èõ ñïóòíèêè» ìîæíî
íàéòè êàê â ìåæäóíàðîäíûõ, òàê è â
Ðîññèéñêèõ Èíòåðíåò-ðåñóðñàõ.

Ìåæäóíàðîäíûå ðåñóðñû:
http://www.solarviews.com/eng/query.htm �
ïëàíåòàðíûé áðàóçåð;
h t tp : / /nssdc .gsfc .nasa .gov/planetary /
planetfact.html;
http://seds.lpl.arizona.edu/nineplanets/
nineplanets.
Ðîññèéñêèå ðåñóðñû:
http://ggreen.chat.ru/
http://symbolist.ru/rus/astrology/planets � ñèì-
âîëû ïëàíåò;
http://www.astrolab.ru/astrsimv.html � ñèìâî-
ëû ïëàíåò;
http://cddb.sai.msu.su/ng/main.htm è äð.

Âûáåðåì èç ïðèâåäåííûõ èñòî÷íè-
êîâ èíôîðìàöèè òðè îñíîâíûå òàáëèöû
(ñì. íèæå).

Äàííûå òàáëèöû 1 â òðàíñïîíèðî-
âàííîì âèäå (òî åñòü ñòðîêè òàáëèöû 1)
áóäóò ñîñòàâëÿòü ïîëÿ áóäóùåé òàáëèöû
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Íàçâàíèå
Name Ìåðêóðèé Âåíåðà Çåìëÿ Ìàðñ Þïèòåð Ñàòóðí Óðàí Íåïòóí Ïëóòîí
Ìàññà (1024 êã)
Mass 0.33 4.87 5.97 0.642 1899 568 86.8 102 0.0125
Äèàìåòð (êì)
Diameter 4879 12104 12756 6794 142984 120536 51118 49528 2390
Ïëîòíîñòü (êã/ì3)
Density 5427 5243 5515 3933 1326 687 1270 1638 1750
Ãðàâèòàöèÿ (ì/ñåê2)
Gravity 3.7 8.9 9.8 3.7 23.1 9 8.7 11 0.6
Ñêîðîñòü îòðûâà
(êì/ñåê)
Escape_V 4.3 10.4 11.2 5 59.5 35.5 21.3 23.5 1.1
Äëèòåëüíîñòü äíÿ (÷àñ)
Day 4222.6 2802 24 24.7 9.9 10.7 17.2 16.1 153.3
Ïåðèãåëèé (106 êì)
Perihelion 46 107.5 147.1 206.6 740.5 1352.6 2741.3 4444.5 4435
Àôåëèé (106 êì)
Aphelion 69.8 108.9 152.1 249.2 816.6 1514.5 3003.6 4545.7 7304.3
Ïåðèîä îðáèòû (ñóò)
O_Period 88 224.7 365.2 687 4331 10747 30589 59800 90588
Îðáèòàëüíàÿ
ñêîðîñòü (êì/ñåê)
Orbital_V 47.9 35 29.8 24.1 13.1 9.7 6.8 5.4 4.7
Íàêëîí îñè (ãðàäóñ)
Tilt 0.01 177.4 23.5 25.2 3.1 26.7 97.8 28.3 122.5
Ñðåäíÿÿ òåìïåðàòóðà
(C)
Temperature 167 464 15 �65 �110 �140 �195 �200 �225
Äàâëåíèå íà ïîâåðõ.
(àòì.)
Pressure 0 93 1 0.007  0.00001
Ìàãíèòíîå ïîëå
Magnetic Äà Íåò Äà Íåò Äà Äà Äà Äà  
Êîìïîíåíòû
àòìîñôåðû
Atmosphere  

CO2,
N2

N2, O2,
Ar

CO2,
N2, Ar

H2, He H2, He
H2, He,
CH4

H2, He,
CH4

N2, CH4,
CO

Òàáëèöà 1. Õàðàêòåðèñòèêè ïëàíåò Ñîëíå÷íîé ñèñòåìû (Planet)

Planet, à ñòîëáöû òàáëèöû 1 áóäóò ñîñòàâ-
ëÿòü îòäåëüíûå çàïèñè Planet. Ðåêîìåíäó-
åòñÿ äëÿ  ïîëåé îïðåäåëèòü êðàòêèå íà-
çâàíèÿ (íà àíãëèéñêîì ÿçûêå). Èñïîëüçó-
åìûå äàëåå èìåíà ïîëåé òàáëèö âûäåëåíû
æèðíûì øðèôòîì.

2. ÔÎÐÌÈÐÎÂÀÍÈÅ È ÍÀÏÎËÍÅÍÈÅ
ÁÀÇÛ ÄÀÍÍÛÕ

Ñîçäàäèì íîâóþ áàçó äàííûõ (ïðåä-
ïîëàãàåòñÿ çíàíèå ïàêåòà MS Access)
Astronomy.mdb. Îðãàíèçóåì òàáëèöó Planet,

èìïîðòèðóÿ ïîäãîòîâëåííûå äàííûå òàá-
ëèöû 1. Ïîëÿ Name, Atmospherå � òåêñòî-
âûå; Magnetic � ëîãè÷åñêîå ïîëå, îñòàëü-
íûå ÷èñëîâûå.

Ñ ïðåäëîæåíèåì Access ñîçäàòü ñ÷åò-
÷èê çàïèñåé � ñîãëàñèòüñÿ è ïåðåîáîçíà-
÷èòü ïîëå Number. Ýòî ïîëå íåîáõîäèìî
äëÿ ñîðòèðîâêè ïëàíåò ïî èõ óäàëåííîñòè
îò Ñîëíöà.

Àíàëîãè÷íî ñîçäàäèì òàáëèöó ñïóò-
íèêîâ ïëàíåò, èñïîëüçóÿ äàííûå òàáëèöû
3. Èñõîäíûå äàííûå ñëåäóåò îòêîððåêòè-
ðîâàòü, ÷òîáû íàçâàíèå ïëàíåòû ïðèñóòñòâî-
âàëî äëÿ êàæäîé çàïèñè âìåñòå ñ íàçâàíè-
åì ñïóòíèêà. Òàêæå èìïîðòèðóåì äàííûå
â òàáëèöó Satellite c ïîëÿìè Name_P, Moon,
Date (ñîîòâåòñòâåííî äëÿ íàçâàíèÿ ïëàíå-
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òû, åå ñïóòíèêà, ãîäà îòêðûòèÿ ñïóòíèêà).
Äëÿ êîððåêòíîñòè èìïîðòà òàáëèö ñëåäóåò
ïðîñëåäèòü, ÷òîáû ïîëÿ íå èìåëè ïðîáå-
ëîâ â íà÷àëå è âíóòðè íàçâàíèÿ.

Ïðåîáðàçóåì ïðè íåîáõîäèìîñòè
ïîëó÷åííóþ ÁÄ ê âåðñèè Access97, äëÿ òîãî
÷òîáû â êà÷åñòâå àëüòåðíàòèâíîãî ñðåäñòâà
ïðè ñîçäàíèè ÁÄ èñïîëüçîâàòü Visual Data
Manager, âõîäÿùèé â ñîñòàâ VB. Ñ åãî
ïîìîùüþ äîáàâèì â ÁÄ Astronomy òàáëè-
öó ñèìâîëîâ ïëàíåò � Astrology.

Îòêðîåì íîâûé VB-
ïðîåêò, âûáåðåì êîìàíäó
ìåíþ Add-Ins → Visual Data
Manager. Â îòêðûâøåìñÿ
îêíå (VisData) âûáåðåì â
ìåíþ File → Open Database
→ Microsoft Access → íàøó
ÁÄ Astronomy.mdb. Â îêíå
Database Windows, ùåëêíóâ
íà òàáëèöå Planet èëè
Satellite, ïðîñìîòðèì ââåäåí-
íóþ èíôîðìàöèþ (èìïîðò
êîòîðîé â òàáëèöû ÁÄ ìîæ-
íî òàêæå îñóùåñòâèòü ÷åðåç
ìåíþ File îêíà VisData).

Ùåëêíåì ïðàâîé êíîïêîé ìûøè â
îêíå Database Windows, â êîíòåêñòíîì
ìåíþ âûáåðåì New Table, ââåäåì èìÿ òàá-
ëèöû Astrology, äîáàâèì (Add Field) ïîëå
Astro (òåêñòîâîå, ðàçìåðîì 10) è ïîëå
Symbol (òèï binary), îáðàçóåì òàáëèöó
(Build the Table).

Äëÿ ââîäà äàííûõ â òàáëèöó
Astrology âîñïîëüçóåìñÿ óòèëèòîé Data
Form Designer, âõîäÿùåé â ñîñòàâ Visual

Ïëàíåòà
Astro

Ñèìâîë
Symbol

Ìåðêóðèé

Âåíåðà

Çåìëÿ

Ìàðñ

Þïèòåð

Ñàòóðí

Óðàí

Íåïòóí

Ïëóòîí

Ïëàíåòà

Name_P

Ñïóòíèê

Moon

Ãîä
îòêðûòèÿ

Date

Ïëàíåòà

Name_P

Ñïóòíèê

Moon

Ãîä
îòêðûòèÿ

Date
Çåìëÿ Ëóíà  Àðèýëü 1851

Äåéìîñ 1877 Áåëèíäà 1986Ìàðñ

Ôîáîñ 1877 Áèàíêà 1986

Àäðàñòåÿ 1979 Êîðäåëèÿ 1986

Àìàëüòåÿ 1892 Êðåññèäà 1986

Ãàíèìåä 1610 Äåçäåìîíà 1986

Ãèìàëèÿ 1904 Äæóëüåòòà 1986

Åâðîïà 1610 Ìèðàíäà 1948

Èî 1610 Îáåðîí 1787

Êàëëèñòî 1610 Îôåëèÿ 1986

Ëèñèòåÿ 1938 Ïîðòèÿ 1986

Ëåäà 1974 Ïàê 1985

Ìåòèñ 1979 Ðîçàëèíäà 1986

Ïàñèôå 1908 Òèòàíèÿ 1787

Cèíîïå 1914 Óìáðèýëü 1851

Þïèòåð

Ýëàðà 1905 Êàëèáàí 1997

Àòëàñ 1980 Ñèêîðàêñ 1997

Êàëèïñî 1980 Ñåòåáîñ 1999

Äèîíà 1684 Ñòåôàíî 1999

Ýíöåëàä 1789 Ïðîñïåðî 1999

Ýïèìåòåé 1980

Óðàí

1986U10 1999
Åëåíà 1980 Äåñïèíà 1989

Ãèïåðèîí 1848 Ãàëàòåÿ 1989

ßïåò 1671 Ëàðèññà 1989

ßíóñ 1966 Íàÿäà 1989

Ìèìàñ 1789 Íåðåèäà 1949

Ïàí 1990 Ïðîòåé 1989

Ïàíäîðà 1980 Òàëàññà 1989

Ôåáà 1898

Íåïòóí

Òðèòîí 1846

Ïðîìåòåé 1980 Ïëóòîí Õàðîí 1978

Ðåÿ 1672

Òåëåñòî 1980

Òåôèÿ 1684

Ñàòóðí

Òèòàí 1655

Òàáëèöà 3. Ñïóòíèêè ïëàíåò (Satellite)

Òàáëèöà 2. Ñèìâîëû
ïëàíåò (Astrology)
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Data Manager, âûçîâåì åå ÷åðåç ïóíêò
ìåíþ Utility. Â îêíå óòèëèòû çàäàäèì èìÿ
ôîðìû (AstroInput), âûáåðåì òàáëèöó äàí-
íûõ Astrology è âñå åå ïîëÿ. Â îáðàçî-
âàííîé ôîðìå frmAstroInput ïðèñóòñòâó-
åò àâòîìàòè÷åñêè ñîçäàííûé ýëåìåíò óï-
ðàâëåíèÿ äàííûìè Data, òåêñòîâîå ïîëå,
îáúåêò OLE, à òàêæå ðàçëè÷íûå êíîïêè
(ðèñóíîê 1), äåéñòâèÿ êîòîðûõ îïðåäåëå-
íû â ãîòîâûõ ñîáûòèéíûõ ïðîöåäóðàõ.

ÎÁÚÅÊÒ ÓÏÐÀÂËÅÍÈß È ÊÎÍÒÐÎËß DATA

    Îáúåêò óïðàâëåíèÿ è êîíòðîëÿ (ÎÓÊ)
Data îïðåäåëÿåò, êàêîé íàáîð çàïèñåé,
êàêèå ïîëÿ èç òàáëèö ÁÄ áóäóò ñâÿçàíû ñ
ýëåìåíòàìè óïðàâëåíèÿ íà ôîðìå äëÿ îòî-
áðàæåíèÿ âûáðàííîé èíôîðìàöèè. Òàêæå
îí ïîçâîëÿåò ïåðåìåùàòüñÿ ïî çàïèñÿì ýòî-
ãî íàáîðà (Recordset). ÎÓÊ Data èìååò ñëå-
äóþùèå âàæíûå ñâîéñòâà (Property):

• Connect îïðåäåëÿåò ôîðìàò äàí-
íûõ (â íàøåì ñëó÷àå Access);

• DatabaseName çàäàåò ïîëíûé ïóòü
ê ôàéëó ÁÄ (Astronomy.mdb);

• RecordSource îïðåäåëÿåò èñòî÷íèê
äàííûõ � ëèáî èìÿ òàáëèöû (â íàøåì ñëó-
÷àå òàáëèöà Astrology), ëèáî îïåðàòîð
SQL, èäåíòèôèöèðóþùèé ëîãè÷åñêîå
ïðåäñòàâëåíèå äàííûõ;

• RecordsetType îïèñûâàåò òèï íà-
áîðà äàííûõ. Â VB èìååòñÿ òðè òèïà íà-
áîðîâ äàííûõ:

Table (òàáëèöà) � îïðåäåëÿåò çàïè-
ñè òîëüêî èç îäíîé òàáëèöû ÁÄ;

Dynaset (äèíàìè÷åñêèé íàáîð) �
îáåñïå÷èâàåò äîñòóï ê ïîëÿì è çàïèñÿì
íåñêîëüêèõ òàáëèö ÁÄ, äëÿ ýòîãî èñïîëü-
çóþòñÿ ôèëüòðû è ìåòîä ïîèñêà Find;

Snapshot (ñòàòè÷åñêèé íàáîð) � êî-
ïèÿ äàííûõ èç òàáëèö, õðàíèòñÿ â ïàìÿòè,
èñïîëüçóåòñÿ òîëüêî äëÿ ÷òåíèÿ.

Recordset � «ìíîæåñòâî çàïèñåé»
âèðòóàëüíîé òàáëèöû ÁÄ, îïðåäåëÿåòñÿ ñî-
ñòîÿíèåì ñâîéñòâà RecordSource.

Âåðíåìñÿ ê çàäàíèþ ââîäà äàííûõ
â òàáëèöó Astrology. Óäàëèì àâòîìàòè÷åñ-
êè ñîçäàííûé OLE-îáúåêò íà ôîðìå, à
âìåñòî íåãî ââåäåì ÎÓÊ PictureBox è ñâÿ-
æåì åãî ñ ýëåìåíòîì óïðàâëåíèÿ Data.

Ëþáûå ýëåìåíòû óïðàâëåíèÿ, áóäü
òî òåêñòîâîå îêíî èëè ìåòêà äëÿ îòîáðà-
æåíèÿ ÷èñëîâîé èëè òåêñòîâîé èíôîðìà-
öèè, îêíî ðèñóíêà èëè îêíî èçîáðàæå-
íèÿ äëÿ îòîáðàæåíèÿ ãðàôè÷åñêîé èíôîð-
ìàöèè, ôëàæîê, ïîçâîëÿþùèé îòîáðàæàòü
áóëåâñêèå (ëîãè÷åñêèå) âåëè÷èíû, � âñå
îíè ïîäêëþ÷àþòñÿ ê îáúåêòó Data ÷åðåç
ñâîéñòâî DataSource (èñòî÷íèê äàííûõ).
Ñâîéñòâî æå DataField (ïîëå äàííûõ) îï-
ðåäåëÿåò èìÿ ïîëÿ â òàáëèöå, ñ êîòîðîé
ñâÿçûâàåòñÿ êîíêðåòíûé ýëåìåíò óïðàâ-
ëåíèÿ.

Çàäàäèì ïðåäëàãàåìûé â ñâîéñòâå
DataSource ýëåìåíò óïðàâëåíèÿ äàííûìè
ñ èìåíåì Data1, à â ñâîéñòâå DataField
óêàæåì äëÿ ñâÿçè ïîëå Symbol. Çàäàäèì
çíà÷åíèå ñâîéñòâà AutoSize=True.

Ïîìåñòèì íà ôîðìó ýëåìåíò óïðàâ-
ëåíèÿ CommonDialog (âêëþ÷èâ åãî ïðåä-
âàðèòåëüíî â ñïèñîê êîìïîíåíòîâ). Îí
áóäåò èñïîëüçîâàòüñÿ äëÿ âûçîâà äèàëîãî-
âîãî îêíà îòêðûòèÿ ôàéëà ðèñóíêà ñ ñèì-
âîëîì ïëàíåòû. Äîáàâèì òàêæå êíîïêó  ñ
íàçâàíèåì «File» è ïðîöåäóðó îáðàáîòêè
ùåë÷êà ìûøè íà êíîïêå äëÿ çàãðóçêè
âûáðàííîé êàðòèíêè â PictureBox:

Ðèñóíîê 1
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Private Sub Command1_Click()
  CommonDialog1.ShowOpen
  Picture1.Picture = LoadPicture_
  (CommonDialog1.FileName)
End Sub

Â îñíîâíîì ìåíþ VB Project →
Properties âûáåðåì îáúåêòîì íà÷àëüíîãî çà-
ïóñêà (Startup Object) ôîðìó frmAstroInput.
Çàïóñòèì ïðèëîæåíèå è, ñ ïîìîùüþ êíîï-
êè Add, çàïîëíèì ïîñëåäîâàòåëüíî òàá-
ëèöó Astrology áàçû äàííûõ íàçâàíèÿìè
ïëàíåò, à òàêæå ñèìâîëàìè ïëàíåò (èç ñî-
îòâåòñòâóþùèõ çàðàíåå ïîäãîòîâëåííûõ
ôàéëîâ ðèñóíêîâ) èç ñâÿçàííûõ ýëåìåí-
òîâ óïðàâëåíèÿ TextBox è PictureBox.

Íà ýòîì çàêàí÷èâàåòñÿ ýòàï ôîðìè-
ðîâàíèÿ è íàïîëíåíèÿ áàçû äàííûõ «Ïëà-
íåòû Ñîëíå÷íîé ñèñòåìû è èõ ñïóòíèêè».

ÐÀÁÎÒÀ Ñ ÁÀÇÎÉ ÄÀÍÍÛÕ

Ðàáîòà ñ
áàçîé äàííûõ
âêëþ÷àåò â ñåáÿ
ñëåäóþùèå âîç-
ìîæíîñòè: ïðî-
ñòåéøèé ïðî-

ñìîòð äàííûõ, êîððåêòèðîâêà äàííûõ (äî-
áàâëåíèå, óäàëåíèå, èçìåíåíèå äàííûõ),
ïîèñê äàííûõ ïî ðàçëè÷íûì êðèòåðèÿì,
ôîðìèðîâàíèå ðàçëè÷íîé ñëîæíîñòè çàï-
ðîñîâ íà âûáîðêó, âûâîä îòîáðàííûõ äàí-
íûõ íà ïå÷àòü.

Â ïðåäûäóùåì ðàçäåëå ïîñðåäñòâîì
Visual Data Manager, à òî÷íåå, Data Form
Designer, ìû íàó÷èëèñü ñîçäàâàòü ôîðìû
äëÿ ïðîñìîòðà èíôîðìàöèè èç áàçû äàí-
íûõ. Â ýòè ñòàíäàðòíûå ôîðìû èìååòñÿ
âîçìîæíîñòü àâòîìàòè÷åñêè ïîìåùàòü
êíîïêè, ïîçâîëÿþùèå âûçûâàòü ñîîòâåò-
ñòâóþùèå ìåòîäû íàáîðà äàííûõ
RecordSet ýëåìåíòà óïðàâëåíèÿ Data:

• Add � äëÿ äîáàâëåíèÿ çàïèñåé â
ÁÄ (ìåòîä AddNew);

• Delete � äëÿ óäàëåíèÿ çàïèñåé èç
ÁÄ (ìåòîä Delete);

• Update � äëÿ îáíîâëåíèÿ  òåêóùåé
çàïèñè â òàáëèöå (ìåòîä Update âûçûâàòü íå
îáÿçàòåëüíî, îáíîâëåíèå ïðîèñõîäèò àâòî-
ìàòè÷åñêè ïðè ïåðåõîäå íà äðóãóþ çàïèñü);

• Refresh � äëÿ îáíîâëåíèÿ òàáëèöû
â ìíîãîïîëüçîâàòåëüñêîì ðåæèìå åå èñ-
ïîëüçîâàíèÿ (ìåòîä Refresh);

• Close � äëÿ âûãðóçêè ôîðìû (ìå-
òîä Unload).

Êðîìå òîãî, ìîãóò èñïîëüçîâàòüñÿ
ìåòîäû äëÿ ïåðåìåùåíèÿ ïî ÁÄ, ñâÿçàí-
íûå íåïîñðåäñòâåííî ñ êíîïî÷êàìè
îáúåêòà Data:

• MoveFirst (êíîïî÷êà |3) � ïåðå-
õîä íà ïåðâóþ çàïèñü,

• MoveLast � (êíîïî÷êà 4|) � ïåðå-
õîä íà ïîñëåäíþþ çàïèñü,

• MoveNext � (êíîïî÷êà 4) � ïåðå-
õîä íà ñëåäóþùóþ çàïèñü,

• MovePrevious � (êíîïî÷êà3) � ïå-
ðåõîä íà ïðåäûäóùóþ çàïèñü.

Ñèíòàêñèñ âûøåóêàçàííûõ ìåòîäîâ
òàêîé: Îáúåêò ÁÄ.RecordSet.ìåòîä

Íàïðèìåð, Data1.RecordSet.AddNew
èëè Data1.RecordSet.MoveFirst

Çàïèñè â ÁÄ íå îáÿçàòåëüíî ïîñëåäî-
âàòåëüíî ïðîñìàòðèâàòü îäíó çà äðóãîé �
ìîæíî ââåñòè êðèòåðèé ïîèñêà è âûâî-
äèòü íà ýêðàí òîëüêî çàïèñè, óäîâëåòâî-
ðÿþùèå óñëîâèþ. Äëÿ ýòîãî ïðåäíàçíà÷å-
íû ìåòîäû FindFirst (íàéòè ïåðâûé),
FindLast (íàéòè ïîñëåäíèé), FindNext (íàé-
òè ñëåäóþùèé), FindPrevious (íàéòè ïðå-
äûäóùèé). Ðàáîòàþò îíè ïðèìåðíî òàê æå,
êàê è ìåòîäû Move, îïèñàííûå âûøå.
Ðàçíèöà ëèøü â òîì, ÷òî ìåòîäû Find äåé-
ñòâóþò óæå â îòîáðàííîì ìíîæåñòâå è
òðåáóþò ïàðàìåòð � ñòðîêó ñ êðèòåðèåì
ïîèñêà â âèäå ëîãè÷åñêîãî âûðàæåíèÿ:
Data1.RecordSet.FindFirst Kritery$,
ãäå Kritery$ � ñèìâîëüíàÿ ñòðîêà âèäà
"(Óñëîâèå 1)[AND ( Óñëîâèå 2) OR
(Óñëîâèå 3) ...]", Óñëîâèå � ýòî åñòü
[Èìÿ ïîëÿ] Îïåðàöèÿ ñðàâíåíèÿ Çíà-
÷åíèå ïîëÿ.

Åñëè íà ôîðìó, èçîáðàæåííóþ íà
ðèñóíêå 1, ïîìåñòèòü åùå îäíó êîìàíäíóþ
êíîïêó äëÿ ïîèñêà ïî êðèòåðèþ è â ñîáû-
òèéíîé ïðîöåäóðå äëÿ ýòîé êíîïêè íàïè-
ñàòü ñîîòâåòñòâóþùèé êðèòåðèé ïîèñêà, òî
áóäåò íàéäåíà, íàïðèìåð, ïëàíåòà Íåïòóí.

Private Sub Command2_Click()
  kr$ = "([Name]=" + Chr(34) +_
   "Íåïòóí" + Chr(34) + ")"
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  Data1.Recordset.FindFirst kr$
End Sub

Äëÿ ðàáîòû ñ ÁÄ îòêðîåì íîâûé
ïðîåêò. Ñîçäàäèì ôîðìó ñ ïîìîùüþ Ìà-
ñòåðà ôîðì Data Form Wizard. Åñëè îí íå
ïðèñóòñòâóåò â ìåíþ Add-Ins, âûáåðåì
êîìàíäó Add-In Manager, à â îòêðûâøåì-
ñÿ ñïèñêå ùåëêíåì ïàðó ðàç íà ýëåìåíòå
VB 6 Data Form Wizard (èëè óñòàíîâèì
ôëàæîê Loaded/Unloaded)  è îäèí ðàç íà
êíîïêå OK. Òåïåðü â ìåíþ ïîÿâèëñÿ íóæ-
íûé ìàñòåð ôîðì, çàïóñòèì åãî. Â îêíå
Introduction ïðåäëàãàåòñÿ âîñïîëüçîâàòü-
ñÿ ðàíåå èñïîëüçóåìûìè íàñòðîéêàìè, íî,
êàê ïåðâîïðîõîäöû, ïðîñêàêèâàåì ñëåäó-
þùèå äâà îêíà, âûáèðàÿ ïî ïóòè òèï áàçû
äàííûõ Access è íàøó ÁÄ Astronomy.mdb.
Â ýêðàíå Form ñòàâèì óêàçàòåëè íà òèïå
ôîðìû Master/Detail è îáúåêòå ADO Data
Control. Îáúåêò ADO (ActiveX Data
Object) îáåñïå÷èâàåò íîâûé, áîëåå ãèá-
êèé ìåòîä äîñòóïà ê äàííûì, ðåêîìåíäó-
åìûé ôèðìîé Microsoft. Â ñëåäóþùåì îêíå
â êà÷åñòâå îñíîâíîé òàáëèöû âûáåðåì
Planet è âñå åå ïîëÿ  (êëàâèøåé 44), ðàñ-
ïîëàãàÿ èõ â íóæíîé ïîñëåäîâàòåëüíîñòè
äëÿ îòîáðàæåíèÿ â áóäóùåé ôîðìå (êàê â
òàáëèöå 1) è â ïîðÿäêå ñëåäîâàíèÿ (ñîð-
òèðîâêà ïî ïîëþ Number). Äàëåå àíàëî-
ãè÷íî ïîñòóïàåì ñ ïîä÷èíåííîé òàáëèöåé
(Detail) ñïóòíèêîâ ïëàíåò (Satellite), êîòî-
ðóþ îòñîðòèðóåì ïî ïîëþ Date (ãîäó îò-
êðûòèÿ). Â îêíå Record Source Relation
óñòàíàâëèâàåì ñâÿçè òàáëèö. Åñòåñòâåííîé
ÿâëÿåòñÿ ñâÿçü òàáëèö ïî èìåíè ïëàíåòû
(áëàãî ìû ïðåäóñìîòðåëè íàëè÷èå ñõîä-
íûõ ïîëåé ïðè ðàçðàáîòêå ñòðóêòóðû òàá-
ëèö), ïîýòîìó îòìå÷àåì ïîëå Name â ãëàâ-
íîé òàáëèöå è ïîëå Name_P â ïîä÷èíåí-
íîé. Â îêíå Control Selection  îòêàæåìñÿ
îò äîïîëíèòåëüíûõ êíîïîê íà ôîðìå
(Clear All), òàê êàê ó íàñ íåò íåîáõîäèìî-
ñòè ðåäàêòèðîâàòü äàííûå òàáëèöû ïëà-
íåò. Çàâåðøèì êíîïêîé Finish ðóòèííóþ
ðàáîòó ìàñòåðà ôîðì.

Ñëåäóþùåå ñîâåðøåíñòâîâàíèå
ôîðìû ïîòðåáóåò ó÷àñòèå ðàçðàáîò÷èêà.
Êàê âèäèì, â ñïèñîê êîìïîíåíòîâ äîáà-
âèëèñü íîâûå ýëåìåíòû óïðàâëåíèÿ: Adodc
è DataGrid.

ÎÁÚÅÊÒ ÓÏÐÀÂËÅÍÈß È ÊÎÍÒÐÎËß
ADODC

    Adodc (ADO Data Control) ôóíê-
öèîíàëüíî ïîäîáåí ðàíåå ðàññìîòðåííî-
ìó ýëåìåíòó óïðàâëåíèÿ Data. Òàê êàê ýëå-
ìåíò èñïîëüçóåò øèðîêèå âîçìîæíîñòè äëÿ
ïîäêëþ÷åíèÿ ê áàçàì äàííûõ, ðàññìîòðèì
ëèøü íåêîòîðûå èç íèõ. Ðàñêðîåì (ùåëê-
íóâ ïðàâîé êëàâèøåé ìûøè íà îáúåêòå)
îêíî ñâîéñòâ Adodc. Íà âêëàäêå General
óêàçàíû ñïîñîáû ïîäêëþ÷åíèÿ ê áàçå äàí-
íûõ.

Â íàøåì ñëó÷àå ìàñòåð ôîðì  ñî-
çäàë ñòðîêó ïîäêëþ÷åíèÿ ê íàøåé áàçå ñ
ïîìîùüþ Jet 3.51 � ÿäðà áàçû äàííûõ òèïà
Access. Äëÿ ïîëüçîâàíèÿ îáúåêòîâ ADO
ê ïðîåêòó àâòîìàòè÷åñêè ìàñòåðîì ôîðì
ïîäêëþ÷åíà áèáëèîòåêà MS ActiveX Data
Objects 2.0 Library. Äëÿ ðàáîòû ñ áàçàìè
äàííûõ, ñîâìåñòèìûõ ñ Access2000, òðå-
áóåòñÿ  áèáëèîòåêà ADO âåðñèè 2.5 è Jet
4.0. Ïîäêëþ÷åíèå ñîîòâåòñòâóþùåé áèá-
ëèîòåêè îñóùåñòâëÿåòñÿ êîìàíäîé ìåíþ
Project → References.

Åñëè áû ìû âûáðàëè äëÿ ïîäêëþ÷å-
íèÿ áàçû äàííûõ ñòðîêó ODBC DSN (Open
DataBase Connectivity Data Source Name),
òî íåîáõîäèìî áûëî áû ïîäêëþ÷èòüñÿ ê
ðàíåå ñîçäàííîìó èñòî÷íèêó äàííûõ ñ
ïîìîùüþ äèñïåò÷åðà ODBC, íàõîäÿùåìó-
ñÿ íà ïàíåëè óïðàâëåíèÿ. Äàííûé èíòåð-
ôåéñ îáû÷íî ñâÿçàí ñ áàçàìè äàííûõ êëè-
åíò/ñåðâåð. Èñòî÷íèê äàííûõ ODBC � ýòî
âûáðàííàÿ êîíôèãóðàöèÿ äðàéâåðà, òî åñòü
íàáîð ôóíêöèé, îáåñïå÷èâàþùèõ ñòàíäàð-
òíûå îáðàùåíèÿ ê ðàçëè÷íûì ôîðìàòàì
áàç äàííûõ.

Êàêèå êîíêðåòíî äàííûå èç ÁÄ áó-
äóò èñïîëüçîâàòüñÿ, óêàçûâàåòñÿ íà âêëàäêå
RecordSource. Òèï êîìàíäû adCmdTable
óêàçûâàåò íà âûáîð êîíêðåòíîé òàáëèöû,
adCmdText âûïîëíÿåò SQL-çàïðîñ ê èñ-
òî÷íèêó äàííûõ.
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ÎÁÚÅÊÒ ÓÏÐÀÂËÅÍÈß È ÊÎÍÒÐÎËß
DATAGRID

 Ýëåìåíò óïðàâëåíèÿ DataGrid
ïðåäñòàâëÿåò âûáðàííûå äàííûå â òàáëè÷-
íîì âèäå � åñòåñòâåííîì ïðåäñòàâëåíèè
ðåëÿöèîííûõ áàç äàííûõ.

Îñíîâíûå ñâîéñòâà
Íàðÿäó ñ èçâåñòíûìè ñâîéñòâàìè, ïðèñóùè-

ìè è äðóãèì îáúåêòàì óïðàâëåíèÿ è êîí-
òðîëÿ, DataGrid îáëàäàåò ñëåäóþùèìè:

AllowAddNew, AllowDelete, AllowUpdate �
ïðè çíà÷åíèè true ïîçâîëÿåòñÿ äîáàâ-
ëÿòü íîâûå, óäàëÿòü è ðåäàêòèðîâàòü çà-
ïèñè îáúåêòà RecordSet;

AllowSizing � ïðè çíà÷åíèè true ïîçâîëÿ-
åò ìåíÿòü ðàçìåðû ñòðîê è ñòîëáöîâ â
òàáëèöå;

ColumnHeaders � ïðè çíà÷åíèè true ïî-
çâîëÿåò âûâîäèòü çàãîëîâêè êîëîíîê.

Ðàñêðîåì îêíî ñâîéñòâ ýëåìåí-
òà óïðàâëåíèÿ DataGrid. Íà âêëàäêå
General  çàäàäèì  çàãîëîâîê (Caption)
«Ñïóòíèêè ïëàíåòû», ðàçðåøèì ðå-
äàêòèðîâàíèå, óäàëåíèå (ïðè âûäåëå-
íèè ñòðîêè è íàæàòèè êëàâèøè
<Delete>) è äîáàâëåíèå èíôîðìàöèè
â ÿ÷åéêè DataGrid. Íà âêëàäêå
Keyboard îñòàâèì ñòàíäàðòíîå óïðàâ-
ëåíèå êëàâèøàìè. Äàëåå, âî âêëàäêå
Columns îïðåäåëèì íà÷àëüíóþ êîëîí-
êó (Column0): íàçâàíèå (Caption)
«Ñïóòíèê» è ïîëå òàáëèöû (DataField)
Moon. Àíàëîãè÷íî, ñòîëáåö 1: íàçâà-
íèå � «Ãîä îòêðûòèÿ», ïîëå � Date.
Íà âêëàäêå Layout âûñòàâèì âûðàâ-
íèâàíèå ïîëÿ «ñïóòíèêè» ïî ëåâîìó
êðàþ. Ïîëå ñ íàçâàíèåì ïëàíåòû òàá-
ëèöû Satellite íå îòîáðàæàåì â
DataGrid, òàê êàê ñâÿçü Master/Detail
ãàðàíòèðóåò, ÷òî ñîîòâåòñòâóþùåå
ïîëå àâòîìàòè÷åñêè âûñòàâëÿåòñÿ

(äàæå ïðè äîáàâëåíèè íîâîãî ñïóòíèêà),
ñîãëàñíî ñâÿçàííîìó ïîëþ â îñíîâíîé òàá-
ëèöå.

Äîïîëíèì àâòîìàòè÷åñêè ñîçäàííóþ
ìàñòåðîì ôîðìó. Ïîäêëþ÷èì òàáëèöó ñèì-
âîëîâ. Íà ôîðìó frmPlanet äîáàâèì ýëå-
ìåíò óïðàâëåíèÿ Data, âûáåðåì äëÿ ñâîé-
ñòâà DatabaseName áàçó äàííûõ
Astronomy.mdb, â êà÷åñòâå RecordSource
îïðåäåëèì òàáëèöó Astrology. Ñäåëàåì
Data íåâèäèìûì (Visible=False). Äîáàâèì
íà ôîðìó PictureBox è ñâÿæåì åãî ñ ïî-
ëåì Symbol èñòî÷íèêà äàííûõ Data1. Ïî-
ñòàâèì äîïîëíèòåëüíóþ ìåòêó «Ñèìâîë
ïëàíåòû» ðÿäîì ñ PictureBox (ðèñóíîê 2).

Ââåäåì äîïîëíèòåëüíûå ñòðîêè êîäà
â ïðîöåäóðó datPrimaryRS_MoveComplete.

strsql = "Select Symbol from
Astrology where Astro"= & Chr$(39) &_
datPrimaryRS.Recordset.Fields("Name").Value_
& Chr(39)
Data1.RecordSource = strsql
Data1.Refresh

Ýòèì ìû ïåðåîïðåäåëÿåì RecordSource
ýëåìåíòà óïðàâëåíèÿ Data îïåðàòîðîì
SQL, êîòîðûé áóêâàëüíî îçíà÷àåò: âûá-

Ðèñóíîê 2
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ðàòü çàïèñü òîëüêî ñ ïîëåì Symbol èç òàá-
ëèöû Astrology, òàêóþ, ÷òî çíà÷åíèå ïîëÿ
Astro äëÿ ýòîé çàïèñè ñîâïàäàåò ñî çíà÷å-
íèåì èìåíè ïëàíåòû òåêóùåé çàïèñè íà-
áîðà äàííûõ ýëåìåíòà óïðàâëåíèÿ
datPrimaryRS. Ïîñëå ýòîãî ìû îáíîâëÿåì
äàííûå ýëåìåíòà óïðàâëåíèÿ Data

Âíåñåì ïîñëåäíèé øòðèõ � íàïèøåì
ðóññêèå íàçâàíèÿ ìåòîê ñîãëàñíî òàáëè-
öå 1. Ïðèëîæåíèå ãîòîâî, ìîæíî ïðîòå-
ñòèðîâàòü åãî.

Íàñòàëà ïîðà ïîçíàêîìèòüñÿ ñ îïå-
ðàòîðàìè SQL � ñàìûì ìîùíûì ñðåäñòâîì
ðàáîòû ñ áàçàìè äàííûõ.

ÂÂÅÄÅÍÈÅ Â SQL

Îï å ð à ò î ðû
SQL (Structured
Query Language �
ÿçûê ñòðóêòóðèðî-
âàííûõ çàïðîñîâ)

ïðåäíàçíà÷åíû äëÿ ôîðìèðîâàíèÿ ðàçëè÷-
íîãî ðîäà çàïðîñîâ ê áàçàì äàííûõ, êî-
òîðûå ïîçâîëÿþò ïîëüçîâàòåëÿì ìàíèïó-
ëèðîâàòü èíôîðìàöèåé â äîñòàòî÷íî ïîë-
íîé ñòåïåíè, êàê-òî:
• ïðîâåñòè âûáîðêó íóæíîé èíôîðìàöèè
èç ðàçëè÷íûõ òàáëèö îäíîé èëè íåñêîëüêèõ
ÁÄ, èñïîëüçóÿ èëè îáðàçîâûâàÿ ëîãè÷åñêèå
ñâÿçè âî âñåé ñîâîêóïíîñòè äàííûõ;
• ìîäèôèöèðîâàòü, ñîçäàâàòü, óäàëÿòü èí-
ôîðìàòèâíóþ èëè ñòðóêòóðíóþ èíôîðìà-
öèþ áàç äàííûõ;
• ïðåäñòàâëÿòü ïîëüçîâàòåëþ âûáðàííûå
äàííûå â íåîáõîäèìûõ ôîðìàòàõ èëè
âèäå;
• èñïîëüçîâàòü ôóíêöèè ÿçûêà ïðîãðàì-
ìèðîâàíèÿ (VB), ïðîâîäèòü àíàëèç èíôîð-
ìàöèè â ÁÄ è ñàìîì çàïðîñå.

Îïåðàòîðû SQL íå ìîãóò èñïîëüçî-
âàòüñÿ â VB íåïîñðåäñòâåííî, îäíàêî,
ñòðîêó çàïðîñà ìîæíî ñîõðàíèòü â ÁÄ â
îáúåêòå QueryDef è â äàëüíåéøåì èñïîëü-
çîâàòü ïàðàìåòðîì â äðóãèõ ôóíêöèÿõ.

SELECT  � îñíîâíîé îïåðàòîð SQL,
ñ êîòîðûì ïðèõîäèòñÿ ðàáîòàòü ïîëüçî-
âàòåëþ ïî âûáîðêå èíôîðìàöèè èç ÁÄ.
Îí èìååò ñëåäóþùóþ ôîðìó:

SELECT [predicate] fieldlist FROM tablelist
[WHERE relations] [group_options] [sort_options]

Áîëüøèìè áóêâàìè áóäåì âûäåëÿòü
êëþ÷åâûå ñëîâà SQL, íî ñ ðàâíûì óñïå-
õîì îïåðàòîð ìîæåò áûòü çàïèñàí è â íèæ-
íåì ðåãèñòðå.

Âûðàæåíèå fieldlist óêàçûâàåò ñïè-
ñîê ïîëåé (ðàçäåëåííûõ çàïÿòîé), êîòî-
ðûå äîëæíû áûòü âêëþ÷åíû â ðåçóëüòèðó-
þùèé íàáîð çàïèñåé. Äëÿ îäíîçíà÷íîñòè
îòäåëüíîå ïîëå ìîæåò èìåòü âïåðåäè óêà-
çàòåëü ðîäèòåëüñêîé òàáëèöû (ñ ðàçäåëè-
òåëåì òî÷êà). Ïîëþ ìîæíî ïðèñâîèòü àëü-
òåðíàòèâíîå èìÿ ñ ïîìîùüþ êëþ÷åâîãî
ñëîâà AS. Ýòî óäîáíî, êîãäà â êà÷åñòâå
ðåçóëüòèðóþùåãî ïîëÿ èñïîëüçóåòñÿ âû-
ðàæåíèå èëè âëîæåííûé çàïðîñ. Âìåñòî
ïåðå÷èñëåíèÿ âñåõ ïîëåé òàáëèöû, ìîæ-
íî ïðèìåíÿòü ñèìâîë øàáëîíà «*».

Âûðàæåíèå  tablelist ñîäåðæèò ñïè-
ñîê òàáëèö èç ðàçíûõ áàç äàííûõ, îòêóäà
ïðîèçâîäèòñÿ âûáîðêà èíôîðìàöèè. Òàê-
æå ïðèìåíÿåòñÿ óäîáíûé ïñåâäîíèì äëÿ
èìåíè òàáëèöû, êîòîðûé ìîæíî èñïîëü-
çîâàòü â çàïðîñå.

Ïðèìåð 1.
Ñäåëàòü âûáîðêó âñåõ õàðàêòåðèñ-

òèê êàæäîé ïëàíåòû èç òàáëèöû Planet.

select * from planet

Ñîçäàäèì ïðîãðàììó äëÿ äàëüíåéøèõ
ýêñïåðèìåíòîâ ïî îñâîåíèþ çàïðîñîâ SQL
è âèçóàëèçàöèè ðåçóëüòàòîâ.

Â íîâîì ïðîåêòå (èëè â ïðåäûäó-
ùåì, èñïîëüçóÿ ôîðìó Form1) ïîäêëþ÷èì
â References áèáëèîòåêè äëÿ ðàáîòû ñ ÁÄ
ïî ADO è DAO òåõíîëîãèè, ñîîòâåòñòâåí-
íî, MS ADO 2.5 Library è MS DAO 3.51
Object Library. Ôóíêöèè DAO íåîáõîäè-
ìû äëÿ ðàáîòû ñ îáúåêòîì QueryDef. Äî-
ïîëíèì ñïèñîê êîìïîíåíò ýëåìåíòàìè
GridData è Adodc, óñòàíîâèì èõ íà ôîð-
ìå (ðèñóíîê 3). Äîáàâèì íà ôîðìó ñëåäó-
þùèå ýëåìåíòû óïðàâëåíèÿ:

• TextBox (îòìå÷åíî êàê «Çàïðîñ
SQL»);

• ListBox (îòìå÷åí êàê «Ñïèñîê çàï-
ðîñîâ»);
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• êíîïêó Command1 ñ íàçâàíèåì «Âû-
ïîëíèòü» (äëÿ âûïîëíåíèÿ çàïðîñà SQL);

• Command2 ñ íàçâàíèåì «→» (äëÿ
äîáàâëåíèÿ ñòðîêè çàïðîñà SQL èç
TextBox â ListBox);

• Command3 ñ íàçâàíèåì «←» (äëÿ
êîïèðîâàíèÿ âûáðàííîãî ýëåìåíòà ListBox
â TextBox);

• Command4 ñ çàãîëîâêîì «Ñîõðà-
íèòü â ÁÄ» (äëÿ ñîõðàíåíèÿ âûáðàííîé
ñòðîêè çàïðîñà â ÁÄ â ïðåäíàçíà÷åííîì
äëÿ ýòîãî îáúåêòå QueryDef);

• Command5 ñ çàãîëîâêîì «Î÷èñ-
òèòü» (äëÿ î÷èñòêè TextBox);

• êíîïêó cmdClose («Âûõîä») äëÿ
âûãðóçêè ôîðìû.

Íèæå ïðèâåäåí êîä ïîëó÷èâøåéñÿ
ïðîãðàììû.

Dim Qry As QueryDef
Dim MyDb As Database

Private Sub Form_Load()
  Set MyDb =_
 OpenDatabase("astronomy.mdb")
End Sub

Private Sub Command1_Click()
  strsql = Text1.Text
  On Error GoTo er
  Adodc1.RecordSource = strsql
  DataGrid1.Visible = True
  Adodc1.Refresh
  Exit Sub
  er: DataGrid1.Visible = False
End Sub

Private Sub Command2_Click()
  List1.AddItem Replace(Text1.Text,
vbCrLf, " ")
End Sub

Private Sub Command3_Click()
  Text1.Text = List1.Text
End Sub

Private Sub Command4_Click()
  Nam = InputBox("Èìÿ çàïðîñà?",_
  "Çàïðîñ â ÁÄ")
  Set Qry = MyDb.CreateQueryDef(Nam,
Text1.Text)
End Sub

Private Sub Command5_Click()
  Text1.Text = ""
End Sub

Private Sub cmdClose_Click()
  Unload Me
End Sub

Âìåñòî ïðèâåäåííîé ó÷åáíîé ïðî-
ãðàììû, ìîæíî èñïîëüçîâàòü ïðèëîæåíèå
VisData (Visual Data Manager) â ñðåäå VB.
Â îêíå SQL Statement ïðîãðàììû VisData
çàïèñûâàåòñÿ çàïðîñ SQL, êîòîðûé ìîæ-
íî âûïîëíèòü (íà äîïîëíèòåëüíûé âîïðîñ,
ÿâëÿåòñÿ ëè äàííûé çàïðîñ SQLPass
Trough, òî åñòü çàïðîñ äîëæåí áûòü âû-
ïîëíåí ñåðâåðîì, îòâåòèòü îòðèöàòåëüíî,
òàê êàê ðàññìàòðèâàåòñÿ òîëüêî ëîêàëüíàÿ
áàçà äàííûõ), à òàêæå ñîõðàíèòü â ÁÄ. Äëÿ
âèçóàëüíîãî ïîñòðîåíèÿ çàïðîñîâ ìîæíî
âîñïîëüçîâàòüñÿ óòèëèòîé VisData �
QueryBuilder.

Ïðîäîëæèì çíàêîìñòâî ñ SQL, ïðî-
âåðÿÿ ñâîè äåéñòâèÿ ïî âûáðàííîé ïðî-
ãðàììå.

Â ñïèñêå ïîëåé îïåðàòîðà SELECT
ìîãóò èñïîëüçîâàòüñÿ êîíñòàíòû, ñèìâîë
êîíêàòåíàöèè (&), ôóíêöèè VB (÷èñëîâûå
èëè ñòðîêîâûå, â çàâèñèìîñòè îò òèïà ïîëÿ).

Ïðèìåð 2.
Âûðàçèòü ðàññòîÿíèå ïëàíåò îò Ñîë-

íöà â àñòðîíîìè÷åñêèõ åäèíèöàõ (1à.å.
=149.6 ìëí. êì � ñðåäíåìó ðàññòîÿíèþ îò
Çåìëè äî Ñîëíöà)

select �ïëàíåòà �&name, �óäàëåíà îò_
Ñîëíöà íà �, (aphelion + _
perihelion)/(149.6*2) & � a.e.� as_
distance from planet

Ïåðåä ñïèñêîì ïîëåé âîçìîæíû ïðå-
äèêàòû ALL, DISTINCT, DISTINCTROW,
TOP n [PERCENT]. Ïðåäèêàò ALL îçíà-
÷àåò âûáîðêó âñåõ çàïèñåé, óäîâëåòâîðÿ-
þùèõ çàïðîñó (óñòàíîâêà ïî óìîë÷àíèþ).
Íàïðèìåð, åñëè âûáèðàòü ïëàíåòû, ó êî-
òîðûõ åñòü ñïóòíèêè, òî íàçâàíèå ïëàíå-
òû áóäåò âñòðå÷àòüñÿ ñòîëüêî ðàç, ñêîëü-
êî ó íåå ñïóòíèêîâ. Äëÿ óíèêàëüíîñòè
èñïîëüçóåòñÿ ïðåäèêàò DISTINCT.

Ïðèìåð 3.
Ïîëó÷èòü îäíîçíà÷íûé ñïèñîê ïëà-

íåò, äëÿ êîòîðûõ îòêðûòû ñïóòíèêè.

Select distinct name_p as [Èìåþò_
ñïóòíèêè] from satellite
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Ïðåäèêàò DISTINCTROW ïîçâîëÿ-
åò îòáðàñûâàòü çàïèñè, êîòîðûå ñîâïàäà-
þò ïîëíîñòüþ.

Ïðåäèêàò TOP n [PERCENT] âêëþ-
÷àåò â íàáîð òîëüêî ïåðâûå n çàïèñåé (ïðî-
öåíòîâ îòîáðàííûõ çàïèñåé) ñ ó÷åòîì ñîð-
òèðîâêè.

Âûðàæåíèå relations ïîñëå êëþ÷åâî-
ãî ñëîâà WHERE îïðåäåëÿåò êðèòåðèé ïî-
èñêà äëÿ âûáîðêè ñòðîê èç òàáëèö ÁÄ è
ïðåäïîëàãàåò íàëè÷èå òðåõ ýëåìåíòîâ:

• èìåíè ñòîëáöà â ëåâîé ÷àñòè;
• îïåðàòîðà ñðàâíåíèÿ;
• èìåíè ñòîëáöà, êîíñòàíòû èëè ïå-

ðå÷íÿ çíà÷åíèé â ïðàâîé ÷àñòè.
Îïåðàòîðû ñðàâíåíèÿ ìîãóò áûòü

ñòàíäàðòíûìè (=, >, <, >=, <=, <>) èëè îïå-
ðàòîðàìè óñëîâèÿ SQL.

Äëÿ îïåðàòîðîâ ñðàâíåíèÿ ñèìâîëü-
íûå äàííûå äîëæíû çàêëþ÷àòüñÿ â îäè-
íàðíûå êàâû÷êè, à äàííûå òèïà äàòà/âðå-
ìÿ îáðàìëÿþòñÿ ñèìâîëîì #.

Ïðèìåð 4.
Êàêàÿ ñðåäíÿÿ òåìïåðàòóðà íà ïî-

âåðõíîñòè ïëàíåòû Ìåðêóðèé è åñòü ëè
òàì àòìîñôåðà?

Select temperature, atmosphere_
from planet where_
name=�Ìåðêóðèé�

Ïðèìåð 5.
Èìååòñÿ ëè õîòÿ áû îäíà ïëàíå-

òà ñ îðáèòàëüíîé ñêîðîñòüþ áîëüøå,
÷åì 40.0 êì/ñåê?

Select name, orbital_v from_
planet where orbital_v > 40.0

Îïåðàòîðû óñëîâèÿ SQL:

• IN (ñïèñîê) � ïðîâåðêà íà ñîâïà-
äåíèå ñ îäíîé èç íåñêîëüêèõ âåëè÷èí èç
ñïèñêà;

• LIKE � ïðîâåðêà âõîæäåíèÿ ïîä-
ñòðîêè â ñòðîêó, èñïîëüçóþòñÿ øàáëîíû:

% âîçìîæíà ëþáàÿ ïîñëåäîâàòåëü-
íîñòü ñèìâîëîâ, âêëþ÷àÿ ïóñòóþ,

_ (ïîä÷åðêèâàíèå) ëþáîé ñèìâîë, çà-
äàåò îäíó ïîçèöèþ â ñëîâå,

[ñïèñîê] îäèíî÷íûé ñèìâîë èç ñïèñ-
êà (íàïðèìåð, [A-K, N]),

[!ñïèñîê] îäèíî÷íûé ñèìâîë íå èç
ñïèñêà;

• IS NULL � ïðèçíàê ïóñòîãî çíà÷åíèÿ;
• BETWEEN ... AND ... � äèàïàçîí

çíà÷åíèé îò è äî, âêëþ÷àÿ ãðàíèöû.
Âîçìîæíî ñîåäèíåíèå âûðàæåíèé ñ

ïîìîùüþ ëîãè÷åñêèõ îïåðàòîðîâ AND,
OR, NOT. Ïîñëåäîâàòåëüíîñòü äåéñòâèé
ìîæíî ïåðåîïðåäåëÿòü ñ ïîìîùüþ ñêîáîê.

Ïðèìåð 6.
Íà êàêèõ ïëàíåòàõ êîìïîíåíòîì àò-

ìîñôåðû ÿâëÿåòñÿ êèñëîðîä è ñðåäíÿÿ òåì-
ïåðàòóðà íà ïîâåðõíîñòè íàõîäèòñÿ â äèà-
ïàçîíå îò  �90° äî 60° Ñ? (Èíûìè ñëîâà-
ìè, ãäå âîçìîæíî íàëè÷èå æèâîé êëåòêè?).

Select name, temperature, atmosphere_
from planet where (atmosphere like_

Ðèñóíîê 3
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�%O%�) and (temperature between �90_
and 60)

Ñîðòèðîâêà çàïèñåé, âîçâðàùàåìûõ
îïåðàòîðîì SELECT, âûïîëíÿåòñÿ ñ ïî-
ìîùüþ äèðåêòèâû ORDER BY. Ñîðòèðî-
âàòü ìîæíî ïî íåñêîëüêèì ïîëÿì, ðàçäå-
ëåííûì çàïÿòûìè.

Ñèíòàêñèñ êîìàíäû ñîðòèðîâêè:
ORDER BY ñïèñîê_ïîëåé [ASC |

DESC], ãäå
ASCending � îáû÷íàÿ ñîðòèðîâêà ïî

óìîë÷àíèþ (â àëôàâèòíîì ïîðÿäêå äëÿ
ñòðîê, îò ìåíüøåãî ê áîëüøåìó äëÿ ÷è-
ñåë, îò ðàííåãî ê ïîçäíåìó äëÿ äàòû);

DESCending � îáðàòíàÿ ñîðòèðîâ-
êà (ïî óáûâàíèþ, îò áîëüøåãî ê ìåíüøå-
ìó), âîçäåéñòâóåò òîëüêî íà îäíî ïîëå.

Ïðèìåð 7.
Âåðíî ëè óòâåðæäåíèå, ÷òî ïî ìåðå

óìåíüøåíèÿ ðàçìåðà ïëàíåòû, åå ìàññà
óìåíüøàåòñÿ?

Select  name, diameter, mass from_
planet order by diameter desc

Âûáðàííûå â îïåðàòîðå SELECT
çàïèñè ìîãóò áûòü ñãðóïïèðîâàíû ñ ïî-
ìîùüþ äèðåêòèâû GROUP BY ïî îòäåëü-
íûì ïîëÿì äëÿ ïîëó÷åíèÿ ñâîäíûõ èòîãî-
âûõ äàííûõ. Äëÿ ýòîãî èñïîëüçóþòñÿ ãðóï-
ïîâûå ôóíêöèè SQL:

• COUNT  � îïðåäåëÿåò ÷èñëî âûá-
ðàííûõ çàïèñåé;

• MIN � ìèíèìàëüíîå çíà÷åíèå ïîëÿ
äëÿ çàïèñåé;

• MAX � ìàêñèìàëüíîå çíà÷åíèå
ïîëÿ äëÿ çàïèñåé;

• SUM � îïðåäåëÿåò ñóììó çíà÷åíèé
ïîëÿ;

• AVG � ïîëó÷àåò ñðåäíåå çíà÷åíèå
ïî ïîëþ.

Äèðåêòèâà GROUP BY ìîæåò âêëþ-
÷àòü íåîáÿçàòåëüíóþ äèðåêòèâó HAVING,
êîòîðàÿ ïîçâîëÿåò âûáðàòü íå âñå ãðóïïû, à
ëèøü ÷àñòü èõ ïî îïðåäåëåííîìó êðèòåðèþ
íà ãðóïïîâûå õàðàêòåðèñòèêè. Â îòëè÷èå îò
äèðåêòèâû HAVING, äèðåêòèâà WHERE íå
ìîæåò áûòü èñïîëüçîâàíà äëÿ çàäàíèÿ îãðà-
íè÷åíèé íà ãðóïïîâûå ôóíêöèè.

Ñîðòèðîâêà âûïîëíÿåòñÿ ïîñëå îò-
áîðà ïî äèðåêòèâå HAVING.

Ïðèìåð 8.
Îïðåäåëèòü ïëàíåòû, ó êîòîðûõ ÷èñ-

ëî ñïóòíèêîâ áîëüøå òðåõ, îòñîðòèðîâàòü
ýòè ïëàíåòû ïî âîçðàñòàíèþ ÷èñëà ñïóò-
íèêîâ.

select name_p as Ïëàíåòà, count(*)_
as [×èñëî ñïóòíèêîâ] from satellite_
group by name_p having count(*)>3_
order by count(*)

Äâà çàïðîñà ìîãóò áûòü îáúåäèíåíû
â îáùóþ òàáëèöó ñ ïîìîùüþ îïåðàòîðà
UNION. Ñîðòèðîâêà ìîæåò áûòü ïðèìå-
íåíà òîëüêî ê îáúåäèíåííîé òàáëèöå ðå-
çóëüòàòîâ. Òàê êàê â îáùåì ñëó÷àå èìåíà
ñòîëáöîâ ìîãóò íå ñîâïàäàòü ïðè îáúåäè-
íåíèè ðàçíûõ òàáëèö (âàæíî ñîâïàäåíèå
êîëè÷åñòâà è òèïà ñòîëáöîâ), òî, âìåñòî
èìåí â äèðåêòèâå ORDER BY, ñëåäóåò çà-
äàâàòü èõ ïîðÿäêîâûå íîìåðà â ïðåäëî-
æåíèè SELECT.

Ïðèìåð 9.
Íà êàêèõ ïëàíåòàõ â àòìîñôåðå ïðè-

ñóòñòâóþò êèñëîðîä è àçîò?

select name, atmosphere  from planet_
where atmosphere like �%N%�
union
select name, atmosphere  from planet_
where atmosphere like �%O%�

 Îïåðàòîðû SQL ìîãóò áûòü âëîæåí-
íûìè. Ïîäçàïðîñû ìîãóò áûòü ïîëåçíû,
êîãäà íóæíî âûáðàòü ñòðîêè èç òàáëèöû
ïî óñëîâèþ, çàâèñÿùåìó îò ñîñòîÿíèÿ äàí-
íûõ â ñàìîé òàáëèöå. Îíè ïîçâîëÿþò êîí-
ñòðóèðîâàòü èç ïðîñòûõ SQL-êîìàíä ìîù-
íûå çàïðîñû.

Ïðèìåð 10.
Íàéòè ñàìóþ áîëüøóþ ïëàíåòó.

select name, diameter from planet_
where diameter= (select_
max(diameter) from planet)

Ïîäçàïðîñ ìîæíî èñïîëüçîâàòü,
íàïðèìåð, â ñëåäóþùèõ ôîðìàõ:

• Ñðàâíåíèå [ANY | ALL] (ïîäçàï-
ðîñ) � ïðîâåðêà èñòèííîñòè ñðàâíåíèÿ ñ
êàêèì-ëèáî çíà÷åíèåì (ANY) èëè ñî âñå-
ìè çíà÷åíèÿìè (ALL) ïîäçàïðîñà;

_
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• [NOT] IN (ïîäçàïðîñ) � ïðîâåðêà
ñîâïàäåíèÿ çíà÷åíèÿ õîòÿ áû â îäíîé èç
çàïèñåé ïîäçàïðîñà;

• [NOT] EXIST (ïîäçàïðîñ) � ïðîâåð-
êà íàëè÷èÿ çàïèñåé ïðè âûáîðêå ïîäçàï-
ðîñà.

Ïîäçàïðîñû ìîãóò çàäàâàòüñÿ òàêæå
â ïðåäëîæåíèè HAVING.

Êðîìå îïåðàòîðà SELECT,  âîçìîæ-
íû ñëåäóþùèå óïðàâëÿþùèå îïåðàòîðû SQL:

• DELETE FROM  èìÿ_òàáëèöû
[WHERE  âûðàæåíèå]

 Óäàëåíèå (áåçâîçâðàòíîå!) çàïèñè
èç òàáëèöû ïî çàäàííîìó êðèòåðèþ (åñëè
îí íå çàäàí, òî óäàëÿþòñÿ âñå çàïèñè);

• INSERT INTO èìÿ_òàáëèöû
SELECT ...

Äîáàâëåíèå ãðóïïû çàïèñåé â òàá-
ëèöó (îáû÷íî, äîáàâëåíèå ïðîèñõîäèò äàí-
íûìè èç äðóãîé òàáëèöû);

• UPDATE èìÿ_òàáëèöû SET ïîëå =
íîâîå_çíà÷åíèå [WHERE  âûðàæåíèå].

Ìîäèôèêàöèÿ çíà÷åíèé ïîëåé â òàá-
ëèöå (åñëè îïóùåíà äèðåêòèâà WHERE,
òî îáíîâëÿþòñÿ âñå çàïèñè). Äàííûé îïå-
ðàòîð ìîæåò áûòü ïðèìåíåí, íàïðèìåð,
äëÿ êàêîé-ëèáî õàðàêòåðèñòèêè ïëàíåòû
ïðè èçìåíåíèè  åäèíèöû èçìåðåíèÿ.

Óïðàæíåíèÿ äëÿ ñàìîñòîÿòåëüíîé
ðàáîòû

1. Ñîñòàâèòü SQL-çàïðîñ.
1) Îïðåäåëèòü ïëîùàäü ïîâåðõíîñ-

òè ïëàíåòû Ìàðñ.
2) Êàêèå ïëàíåòû â äèàìåòðå ìåíü-

øå, ÷åì Çåìëÿ?
3) Êàêàÿ ïëàíåòà ñîëíå÷íîé ñèñòå-

ìû ñàìàÿ ìàëàÿ è ñàìàÿ áîëüøàÿ?
4) Äëÿ êàêèõ ïëàíåò íå èçâåñòíî, åñòü

ëè ó íèõ ìàãíèòíîå ïîëå?

5) Ñêîëüêî ñïóòíèêîâ ó êàæäîé ïëà-
íåòû?

6) Êàêèå ïëàíåòû èìåþò áîëüøå åñ-
òåñòâåííûõ ñïóòíèêîâ, ÷åì Çåìëÿ?

7) Íàéòè ïëàíåòû, èìåþùèå îäèíà-
êîâîå êîëè÷åñòâî ñïóòíèêîâ.

8) Íàéòè ïëàíåòû â òàáëèöå Planet,
äëÿ êîòîðûõ íåò äàííûõ â òàáëèöå Satellite.

9) Êàêèå ïëàíåòû âõîäÿò â òðîéêó
ñàìûõ áîëüøèõ ïëàíåò (íàçâàíèå, ðàçìåð,
îòñîðòèðîâàòü ïî ðàçìåðó).

10) Â êàêîì ãîäó îòêðûòî íàèáîëüøåå
êîëè÷åñòâî ñïóòíèêîâ? (Ñ ÷åì ýòî ñâÿçàíî?)

11) Îïðåäåëèòå äëÿ ïëàíåò, êàêèå
ñïóòíèêè íàéäåíû ïîñëåäíèìè ïî âðåìå-
íè (óïîðÿäî÷èòü ïî äàòå).

2. ×òî ìîæíî ñêàçàòü ïî ïîâîäó ñëå-
äóþùèõ óòâåðæäåíèé? Äàéòå îáîñíîâàíûé
îòâåò ñ ïîìîùüþ SQL-çàïðîñà. Åñòü ëè èñ-
êëþ÷åíèÿ?

12) ×åì äàëüøå ïëàíåòà îò Ñîëíöà,
òåì îíà õîëîäíåå.

13) ×åì äàëüøå ïëàíåòà îò Ñîëíöà,
òåì åå ïåðèîä âðàùåíèÿ âîêðóã Ñîëíöà
áîëüøå.

14) ×åì áîëüøå äèàìåòð ïëàíåòû,
òåì áîëüøå ó íåå ñïóòíèêîâ.

15) ×åì áîëüøå ìàññà ïëàíåòû, òåì
áîëüøå ó íåå ñïóòíèêîâ.

3. Ïðîâåñòè èññëåäîâàíèå ïðè ðà-
áîòå ñ ÁÄ.

16) ×òî ìîæíî ñêàçàòü îòíîñèòåëü-
íî îðáèòàëüíîé ñêîðîñòè, â çàâèñèìîñòè
îò óäàëåííîñòè ïëàíåòû îò Ñîëíöà?

17) Ïðîâåñòè ïðîâåðêó óíèêàëüíî-
ñòè íàçâàíèé ñïóòíèêîâ.

18) Êàêèå èç ñïóòíèêîâ (è êàêèõ
ïëàíåò) íàçâàíû â ÷åñòü ãåðîåâ òðàãåäèè
Øåêñïèðà «Îòåëëî»?
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